Chapter 360

Mixed Models Tests for Slope-Interaction in a 2×2 Factorial 2-Level Hierarchical Design with Fixed Slopes (Level-2 Randomization)

Introduction

This procedure calculates power and sample size for a two-level hierarchical mixed model which is randomized at the second level (subjects). The associated longitudinal study uses a 2-by-2 factorial design with two binary factors X and Z, each with two possible values (0 and 1). This results in four treatment arms. The goal of the study is to test whether the slopes of subjects across time are different from what would be expected if the effect of the two factors were additive. That is, one wants to test the three-way interaction between the two binary factors and time.

In many cases, this design is called a repeated measures design. The classic example is a study in which the level-2 units are subjects and the level-1 units are time points at which measurements are taken. This factor is nested in the level-2 units.

This procedure is for longitudinal studies in which each subject is measured two or more times.

In this case of level-2 randomization, each level-2 unit (subject) is randomly assigned to one of the four treatments combinations.

Each subject is assumed to have a common, fixed slope in each group.
Mixed Models Tests for Slope-Int’n in a 2×2 Fact. 2-Lvl Hier. Design with Fixed Slopes (Lvl-2 Rand.)

Technical Details

Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 5, section 5.6, pages 172-176. The linear mixed model that is adopted is:

\[ Y_{ij} = \beta_0 + \delta_X X_{ij} + \delta_Z Z_{ij} + \delta_T T_{ij} + \delta_{XZ} X_{ij} Z_{ij} + \delta_{XT} X_{ij} T_{ij} + \delta_{ZT} Z_{ij} T_{ij} + \delta_{XZT} X_{ij} Z_{ij} T_{ij} + u_i + e_{ij} \]

where

- \( Y_{ij} \) is the continuous response of the \( j^{th} \) level-1 unit, within the \( i^{th} \) level-2 unit.
- \( X_{ij} \) is an indicator variable that is equal to “1” if the \( i^{th} \) level-2 unit is assigned to receive intervention \( X \) and “0” otherwise. Thus, \( X_{ij} = X_i \) for all \( i \).
- \( Z_{ij} \) is an indicator variable that is equal to “1” if the \( i^{th} \) level-2 unit is assigned to receive intervention \( Z \) and “0” otherwise. Thus, \( Z_{ij} = Z_i \) for all \( i \).
- \( \beta_0 \) is the fixed intercept.
- \( \delta_X \) is the treatment effect of factor \( X \).
- \( \delta_Z \) is the treatment effect of factor \( Z \).
- \( \delta_{XZ} \) is the interaction effect of factors \( X \) and \( Z \).
- \( \delta_{XT} \) is the interaction effect of factors \( X \) and \( T \).
- \( \delta_{ZT} \) is the interaction effect of factors \( Z \) and \( T \).
- \( \delta_{XZT} \) is the 3-way interaction effect of \( X, Z, \) and time. The is the coefficient of interest.
- \( u_i \) is the random intercept for the \( i^{th} \) level-2 unit. It is distributed as \( N(0, \sigma_u^2) \).
- \( e_{ij} \) is the level-1 random intercept effect that is distributed as \( N(0, \sigma_e^2) \).
- \( \sigma^2 \) is the variance of \( Y \) when slopes are fixed, where \( \sigma^2 = \sigma_u^2 + \sigma_e^2 \).
- \( \rho_1 \) is the correlation among level-1 units which are in a particular level-2 unit.
- \( K_{0,0} \) is the number of level-2 units for which \( X = 0 \) and \( Z = 0 \).
- \( K_{0,1} \) is the number of level-2 units for which \( X = 0 \) and \( Z = 1 \).
- \( K_{1,0} \) is the number of level-2 units for which \( X = 1 \) and \( Z = 0 \).
- \( K_{1,1} \) is the number of level-2 units for which \( X = 1 \) and \( Z = 1 \).
- \( M \) is the number of level-1 units per level-2 unit. It is the number of measurement times.

The test of significance of the product \( X_{ijk} Z_{ijk} T_{ijk} \) is the interaction effect of \( X, Z, \) and \( T \).

This is the test statistic of interest. It tests whether the subject-specific slopes behave the same across all treatment combinations.

Assume that \( \delta_{XZT} \) is to be tested using a Wald test. The statistical hypotheses are \( H_0: \delta_{XZT} = 0 \) vs. \( H_a: \delta_{XZT} \neq 0 \).

The power is calculated using

\[
Power = \Phi \left( \frac{\delta_{XZT}}{\sigma} \sqrt{\frac{K_{0,0} M \text{Var}(T)}{f \left( \frac{1}{K_{0,0}} + \frac{1}{K_{1,1}} + \frac{1}{K_{1,0}} + \frac{1}{K_{0,1}} \right)}} - \Phi(1 - \alpha/2) \right)
\]

where \( f = 1 - \rho_1 \) and \( \text{Var}(T) = \sum_{j=1}^{M} (T_j - \bar{T})^2 / M \).
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are $\delta_{XYZ}$ (Three-Way Interaction), Power, $K_00$, and $M$.

Under most situations, you will select either Power to calculate power or $K_00$ to calculate the number of level-2 units. Occasionally, you may want to fix the number of level-2 units and find the necessary average number of level-1 units.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found. This search considers integer values of $K_00$ and $M$ only.

Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Sample Size – Number of Level-1 and Level-2 Units

K00 (Group 00 Count (X=0, Z=0))

This is the number of level-2 units (e.g., classes) in group 00, which we have designated as the group in which both of the binary factors X and Z are zero (i.e., control group). The total sample size for this group is equal to the K00 times M.

Each of the factors X and Z has two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 0 and Z = 0, neither of the interventions occur. Hence this is the control group.

This value must be a positive integer.

You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

K01 (Group 01 Count (X=0, Z=1))

This is the number of level-2 units (e.g., classes) in group 01, which we have designated as the group in which X is zero and Z is one (i.e., only Z is active). The total sample size for this group is equal to K01 times M.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 0 and Z = 1, an intervention occurs for Z but not X.

Using Multiples of K00

If you simply want a multiple of the value for group 00, enter the multiple followed by "K00", with no blanks. If you want to use K00 directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10K00 2K00 0.5K00 K00.

List

You can use a list of values such as "10 20 30" or "K00 2K00 3K00".

K10 (Group 01 Count (X=1, Z=0))

This is the number of level-2 units (e.g., classes) in group 10, which we have designated as the group in which X is one). The total sample size for this group is equal to K10 times M.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 1 and Z = 0, an intervention occurs for X but not Z.

Using Multiples of K00

If you simply want a multiple of the value for group 00, enter the multiple followed by "K00", with no blanks. If you want to use K00 directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10K00 2K00 0.5K00 K00.

List

You can use a list of values such as "10 20 30" or "K00 2K00 3K00".

K11 (Group 11 Count (X=1, Z=1))

This is the number of level-2 units (e.g., classes) in group 11, which we have designated as the group in which X is one and Z is one. The total sample size for this group is equal to K11 times M.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 1 and Z = 1, an intervention occurs for both factors.
**Using Multiples of K00**

If you simply want a multiple of the value for group 00, enter the multiple followed by "K00", with no blanks. If you want to use K00 directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10K00 2K00 0.5K00 K00.

**List**

You can use a list of values such as "10 20 30" or "K00 2K00 3K00".

**M (Level-1 Unit Count Per Level-2 Unit)**

This is the number of level-1 units (e.g., time points) per level-2 unit (e.g., subjects). This value is the same for all four groups.

This value must be a positive number that is at least 2. You can use a list of values such as "10 15 20". A separate analysis will be run for each element in the list.

---

**Effect Size**

\( \delta_{XYT} \) (Three-Way Interaction)

Enter one or more values for \( \delta_{XZT} \), the regression coefficient of the \( X_{ij} \times Z_{ij} \times T_{ij} \) term in the mixed model. It is this interaction among the four group slopes at which the study is to be powered. That is, the power is the probability of detecting an interaction of at least this amount. This value is not the true interaction. Rather, it is the interaction that you want to be able to detect.

**Slope Interaction**

Suppose we define \( \beta_{xz} \) to be the slope of the level-2 units in the \((x,z)\) cell in a 2-by-2 factorial table. For example, \( \beta_{10} \) is the slope of the data in the \((1,0)\) cell in a 2-by-2 factorial table of \( X \) and \( Z \). This interaction is a difference of slope differences. It is constructed as the difference between the two slope differences \((\beta_{11} - \beta_{10})\) and \((\beta_{01} - \beta_{00})\). It is the failure of the two interventions to act independently of each other.

\( \delta_{XZT} \) can be any non-zero value (positive or negative). Since this procedure uses a two-sided test statistic, you will get the same result with either positive or negative values.

**Syntax**

You can enter a single value such as 10 or a series of values such as 10 20 30 or 5 to 50 by 5. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

**\( \sigma \) (Standard Deviation)**

Enter the standard deviation of \( Y_{ij} \) assuming the slopes are fixed. You might obtain variance component estimates for the quantities used to form \( \sigma^2 \) from previous studies or a pilot study.

**Definition of \( \sigma^2 \)**

For clarity, in the following we are using square-brackets to enclose the subscripts.

Let

\[ V(e) = \text{Variance of error term, } e_{[ij]} \]  
\[ V(2) = \text{Variance of level-2 random intercept, } u_{[i]} \]  
\[ \sigma^2 \text{ is defined as } \sigma^2 = V(2) + V(e). \]
Range

σ must be a positive number.

Syntax

You can enter a single value such as 5 or a series of values such as 1 3 5 7 9 or 1 to 10 by 1. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Help for Estimating σ

Press the small 'σ' button to the right to obtain calculation options for estimating the standard deviation.

ρ1 (Correlation Among Level 1 Units)

This is the correlation of each pair of level 1 units in a particular level 2 unit.
Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.5.
You may enter a single value or a list of values.
Example 1 – Calculating Power

Suppose that a two-level hierarchical design is planned in which there will be two interventions. Each intervention will be whether one of two drugs is administered. There will be only one measurement per subject and the four treatments will be applied to whole clusters (level-two units). The analysis will be a mixed model of continuous data using the model given earlier in this chapter. The slopes will be assumed to be fixed. The following parameter settings are to be used for the power analysis: $\delta_{xzt} = 4, 5; \sigma = 9.7; \rho_1 = 0.06; M = 5; \alpha = 0.05$; and $K_{00} = K_{01} = K_{10} = K_{11} = 5$ to 20 by 5. Find the power of each combination of parameter settings.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Slope-Int’n in a 2×2 Fact. 2-Lvl Hier. Design with Fixed Slopes (Lvl-2 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab
Solve For Power
Alpha 0.05
K00 (Group 00 Count (X=0, Z=0)) 5 10 15 20
K01 (Group 01 Count (X=0, Z=1)) K00
K10 (Group 10 Count (X=1, Z=0)) K00
K11 (Group 11 Count (X=1, Z=1)) K00
M (Level 1 Units Per Level-2 Unit) 5
$\delta_{xzt}$ (Three-Way Interaction) 4 5
$\sigma$ (Standard Deviation) 9.7
$\rho_1$ (Correlation Among Level-1 Units) 0.06

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Lvl 1 Cnt N</th>
<th>Grp00 Lvl 2 Cnt K00</th>
<th>Grp01 Lvl 2 Cnt K01</th>
<th>Grp10 Lvl 2 Cnt K10</th>
<th>Grp11 Lvl 2 Cnt K11</th>
<th>Lvl 1 Cnt M</th>
<th>2 x 2 Interaction Delta</th>
<th>Std Dev</th>
<th>ICC Lvl-1 Units p1</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.3241</td>
<td>100</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>4.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.5626</td>
<td>200</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>5</td>
<td>4.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.7404</td>
<td>300</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>5</td>
<td>4.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.8526</td>
<td>400</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>5</td>
<td>4.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.4680</td>
<td>100</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.7575</td>
<td>200</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>5</td>
<td>5.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9025</td>
<td>300</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>5</td>
<td>5.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9640</td>
<td>400</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>5</td>
<td>5.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
</tbody>
</table>
References

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units in the study.
K00 (Group 00 Count (X=0, Z=0)) is the number of level-2 units in Group 00 (X=0 and Z=0).
K01 (Group 01 Count (X=0, Z=1)) is the number of level-2 units in Group 01 (X=0 and Z=1).
K10 (Group 10 Count (X=1, Z=0)) is the number of level-2 units in Group 10 (X=1 and Z=0).
K11 (Group 11 Count (X=1, Z=1)) is the number of level-2 units in Group 11 (X=1 and Z=1).
M is the number of level-1 units per level-2 unit (i.e., the number of time points).
δxz_t is the 3-way interaction among the subject-specific slopes (β11 - β10) - (β01 - β00) at which the power is calculated.
σ is the standard deviation of the Yijk assuming a fixed-slope model.
p1 is the correlation among level-1 units in a particular level-2 unit.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.

Summary Statements
A total sample size of 100 observations, were obtained by sampling 5 level-2 units in group 00, 5 level-2 units in group 01, 5 level-2 units in group 10, and 5 level-2 units in group 11. Finally, 5 level-1 units (repeated measurements) were obtained from each level-2 unit. This sample achieves 32% power to detect a three-way interaction among the subject-specific slopes of at least 4.00. This 2×2 interaction was formed from the four group slopes across time using the following formula: δxz_t = (β11 - β10) - (β01 - β00). The standard deviation is 9.70. The intraclass correlation coefficient of level-1 units is 0.060. A test based on a mixed-model analysis assuming fixed slopes will be used. This test will be conducted at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power for the various parameter settings.
Example 2 – Calculating Sample Size (K00)

Continuing with the last example, suppose the researchers want to determine the value of K00 needed to achieve 90% power for both values of $\delta x z\tau$.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Slope-Int’n in a 2×2 Fact. 2-Lvl Hier. Design with Fixed Slopes (Lvl-2 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>K00 (Group 00 Count (X=0, Z=0))</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>K01 (Group 01 Count (X=0, Z=1))</td>
<td>K00</td>
</tr>
<tr>
<td>K10 (Group 10 Count (X=1, Z=0))</td>
<td>K00</td>
</tr>
<tr>
<td>K11 (Group 11 Count (X=1, Z=1))</td>
<td>K00</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level-2 Unit)</td>
<td>5</td>
</tr>
<tr>
<td>$\delta xz\tau$ (Three-Way Interaction)</td>
<td>4 5</td>
</tr>
<tr>
<td>$\sigma$ (Standard Deviation)</td>
<td>9.7</td>
</tr>
<tr>
<td>$\rho_1$ (Correlation Among Level-1 Units)</td>
<td>0.06</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Lvl 1 Cnt</th>
<th>Grp00 Lvl 2 Cnt</th>
<th>Grp01 Lvl 2 Cnt</th>
<th>Grp10 Lvl 2 Cnt</th>
<th>Grp11 Lvl 2 Cnt</th>
<th>2 × 2 Interaction Cnt</th>
<th>Lvl 1 Cnt</th>
<th>2 × 2 Std Dev</th>
<th>ICC Lvl-1 Units</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9090</td>
<td>480</td>
<td>24</td>
<td>24</td>
<td>24</td>
<td>24</td>
<td>5</td>
<td>4.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9025</td>
<td>300</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>5</td>
<td>5.00</td>
<td>9.70</td>
<td>0.060</td>
<td>0.050</td>
</tr>
</tbody>
</table>

This report shows the power for each of the scenarios.
Example 3 – Validation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) page 176 provide a table in which several scenarios are reported. We will validate this procedure by duplicating the first row. The following parameter settings are to be used for the power analysis: \( \delta x z t = 0.4; \sigma = 4; \rho_1 = 0.1; M = 5; \) power = 0.8; and \( \alpha = 0.05 \). The reported value of K00, K01, K10, K11 is 283 and the attained power at 0.801.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **Mixed Models Tests for Slope-Int’n in a 2×2 Fact. 2-Lvl Hier. Design with Fixed Slopes (Lvl-2 Rand.)** procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>K00 (Group 00 Count (X=0, Z=0))</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>K01 (Group 01 Count (X=0, Z=1))</td>
<td>K00</td>
</tr>
<tr>
<td>K10 (Group 10 Count (X=1, Z=0))</td>
<td>K00</td>
</tr>
<tr>
<td>K11 (Group 11 Count (X=1, Z=1))</td>
<td>K00</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level-2 Unit)</td>
<td>5</td>
</tr>
<tr>
<td>( \delta x z t ) (Three-Way Interaction)</td>
<td>0.4</td>
</tr>
<tr>
<td>( \sigma ) (Standard Deviation)</td>
<td>4</td>
</tr>
<tr>
<td>( \rho_1 ) (Correlation Among Level-1 Units)</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Total</th>
<th>Grp00</th>
<th>Grp01</th>
<th>Grp10</th>
<th>Grp11</th>
<th>Lvl 1</th>
<th>2 × 2 Interaction</th>
<th>Std Dev</th>
<th>ICC Lvl-1 Units</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cnt</td>
<td>Cnt</td>
<td>Cnt</td>
<td>Cnt</td>
<td>Cnt</td>
<td>Cnt</td>
<td></td>
<td>Cnt</td>
</tr>
<tr>
<td>Power</td>
<td>0.8006</td>
<td>N</td>
<td>K00</td>
<td>K01</td>
<td>K10</td>
<td>K11</td>
<td>M</td>
<td>( \delta x z t )</td>
</tr>
<tr>
<td></td>
<td>5660</td>
<td>283</td>
<td>283</td>
<td>283</td>
<td>283</td>
<td>5</td>
<td>0.40</td>
<td>4.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.100</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Alpha</td>
<td>0.050</td>
</tr>
</tbody>
</table>

PASS also calculates the value of K00 to be 283 and the power as 0.8006.